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Introduction
The Internet Site Blaster (tm) uses a database format.    Each page of Internet information is 
considered one record, unless you are in the table view, when one record will correspond to one 
line of the table.      The individual text areas on a page where information can be entered are 
known as fields.    The entire collection of records is called a database.

 Each database has its own particular characteristics which, with Internet Site Blaster, are 
described in what is known as the File Definition. An Index organizes the information in one field 
in such a way as to allow rapid access to that field's information.    The Internet Site Blaster can 
have an Index on one or more fields.    If you like, you can make indexes on each of the four fields 
in the database.

The program    ships with an index already assigned to the Description field.    You will need to 
create indexes on other fields for yourself.    

After you start the program, go to the File menu and select "Indexes".    You will be shown the 
Indexes dialog box.    Next, highlight the name of one of the fields by clicking on its name on the 
left.    Then select "Add" and this field will be transferred to the right side and an Index will be 
created when you leave this dialog box.    It is recommended to at least create indexes for the 
Description and the Address fields.

The Icon Bar provides quick access to the most commonly used functions:

The Form View

This is the most commonly used view for entering, viewing, and working with data.    There are 
other views however, which at times can be more useful to you than the form view.

Table View

The Table View displays many records at one time for easier viewing of groups of records.    The 
layout of the table view can be modified so that as much or as little of any field shows on the 
screen.

Save Record

When you have added or changed information in the database, you can use this icon to save your 
work.      Any time that you make changes in the database you will be prompted to save the new 
information.



Add Record

To add new information, choose this icon to begin entering new Internet data.

Change Record

When information needs to be edited or modified, select this icon to begin entering the desired 
changes in the Table View. In the Form View, simply click on a field to begin data entry.

Delete Record

When you need to destroy a record, then select this icon.    You will be prompted to make certain 
that you want to delete the record.

Registration Benefits

Choose this icon to view the benefits of registration and the bonus database and utilities that 
come with the Registered version of Internet Site Blaster.

Help

The Help Button to the far right of the icon bar can give you access to this help file from within the
program.

Group Find

Group Find is found on the icon bar at the bottom of the screen.    Information is gathered into a 
group if it meets certain search criteria that you specify.

Find First Matching Item

Find First will locate an individual record that meets the criteria you have selected for your search. 
The searching must be done on an indexed field, unlike the Group Find that can search indexed 
and non-indexed fields.    The results are immediate, even when searching through an entire 
30,000 record database.    If the exact match is not located, then Find First will make its best guess
for a record that provides a close or approximate match.



Pause

Also on the lower icon bar, the icon with the double bar is present to allow you to pause in the 
process of performing a database operation.    De-select the icon to resume the paused procedure.

Stop

The solid square icon adjacent to the Pause button, allows you to terminate any    database 
operation in progress.

 VCR Controls

The controls for traveling through the database are similar to those seen commonly on a video 
cassette recorder (VCR).    The buttons on either end take you to the beginning or the end of the 
database instantly.    The double arrows pointing to the left take you rapidly through the database 
to the beginning.    The double arrows pointing to the right allow you to scan rapidly to the end of 
the database, similar to Fast-Forward on a VCR.    The single arrows pointing left and right move 
one page, or record, at a time.    The single arrow pointing up is used only in the Table View.

Each function of the VCR buttons has a keyboard counterpart.    For instance, the left and right 
arrow keys can take you one record backward or forward in the database.    If you hold the left or 
right arrow key down, then the database will be rapidly scanned in the chosen direction, just like 
the Fast-Forward or Fast-Reverse keys.      The PgUp and PgDn keys will also emulate Fast-
Forward and Fast-Reverse.    The Home key and the End key will jump to the first page and last 
page of the database, respectively.    If your mouse hand tires easily, the keyboard approach to 
navigating can prove helpful.



Displaying Internet Information
There are two ways to view Internet information from within the database:

The Form View:

This view is the main view from which you will enter data, perform searches, and move through 
the database.    Both the top icon bar and and bottom icon bar contain all of the basic functions 
you will need for most activities.    The menus allow other, more complicated procedures to be 
performed.    These commands are discussed in the Menu Command Summary.

The Table View:

It is helpful sometimes to be able to view the Internet information in the database in a table format.
This is true particularly when search criteria are specified and the files matching that criteria are 
collected into one set.    By using the Table View, you can view the Internet sites matching the 
search criteria very quickly to find sites of interest easily.

The layout of the table view can be changed by adjusting column sizes with your mouse by using 
the Layout command under the Edit menu item.    See    Menu Command Summary .

Registration Benefits
Order Form



Finding Internet Information
One of the most important uses of a database program like this is the ability to search for specific 
information.    When you know specifically what you are searching for, you want to use the Find 
First function:

The key to using the Find First function is to use this on the appropriate indexed field.    If the item 
you are searching for is to be found in the description field, then you must make sure that you 
have the index set to "Description" or the search will produce undesirable results.    If you are 
searching for something in a particular Category field, then "Category" must be set as the index.    
If you have no indexes assigned, this icon will be dimmed and unavailable.    Go to "Indexes" 
under the File menu to add indexes to the database.

When you select the Find First function, you will be asked to fill in box called "Key Lookup" which
look like this:

The term "Key Lookup" means that the search will be made on a particular indexed field.    

For instance, you might use the Find First function to locate the first instance of "Governmental" 
in the field "Description". The look-up is almost instantaneous no matter what the size of the 
database is.    You will see the particular Internet site that matches the search item presented to 
you.

If you were to search for "Governmental Agencies" , you will notice that there is not an exact 
match, so the search function finds the first match that comes close to the search criteria.    The 
Internet site presented to you may be titled "Government Agency" instead.    The message at the 
bottom of the screen will tell you that an exact match was not found.

When you are not sure of the exact word or terms that you want to search for, then you can use 
the "Group Find" function to find all of the records that are close to your search word or phrase.

This function will not only find the first occurrence of a specified term, but will goup all of the files
in the database that match the search criteria.    You can then work with these as a subset of the 
whole database.    To return to the use of the whole database you can click on the icon, and it will 
no longer be depressed.    You can then resume working with the entire database as desired.      

There are several important things to know about using the "Group Find" function.



For the "Group Find", you will be asked to fill out a "Group Display" dialog box, like the one 
above.    By simply clicking on the desired field to search on, then the operator (usually the "LIKE"
operator), then entering a value and selecting "Ok" on the bottom button, you will have 
designated a search formula by which records will be found.

In the example above, Description is clicked on, then "LIKE", and then the word "movie" is 
entered into the value box.      The button at the bottom of the screen will say "Value" on it.    When 
the word "movie" is entered, the Value button is clicked and the button changes to "Ok".    Clicking
on this button again will start the search.

If you know exactly what you want to find, just enter the word, by itself, like "movie".      However, if
you want to find all sites that have the word movie, or movies anywhere in the description, then 
the use of the wildcard * is helpful.    By entering the value as *movie* you will find a much broader
range of sites that have to do with that topic. 

After the first site is found, the search will stop on that particular Internet site.      If you press the 
Fast Forward icon at this time, then the search will continue through the whole database.    Once it
is finished searching, it is interesting to look at the group of sites collected by going to the Table 
View. It takes a few moments to display the table, but it helps you to see what your search has 
produced.    Again, when you press on the Group Find icon, it will no longer be in the depressed 
position and you will be returned to the entire database.

As tempting as it may be, do not use the other symbols and numbers for your searches as you 
will not get usable results. The equal sign is intended for mathematic functions that are used to 
search on, not applicable in this database.



Entering Internet Information
The Form View is the mode that you will use when you are entering Internet information into the 
database.    Select    the Add icon to begin a new page.    If the page already exists, simply click the 
mouse on the desired field and enter data.    Then press the Enter key to go to the other fields.    
You can enter data into the other fields or just repeatedly press the Enter key until you leave the 
form.    You will be asked if you want to save your information.

IMPORTANT NOTE:    If you do not press Enter to leave the    form, you must select the Save icon 
to save your work before  you move to other pages of the database, or it will be as if you never 
entered the information.

If you use the Table View to enter information, you must first select the Add icon to add a new 
page, or the Change icon to modify information already present.    When you have completed your 
data entry, you must select the Save icon to save your work.

Importing Data:  One of the ways that you can quickly add Internet information to the database is 
to import information.    By selecting "Import" from the File menu, you can add information from a 
specially prepared text file.    First of all, the text file must be pure ASCII, meaning there must be no
embedded control codes in the file like many word processors insert.    Usually a word processor 
has the ability to save text as plain text or ASCII format.    Text editors generally save the text as 
ASCII text.

The preparation of the text file is simple.    All you have to do is put the Internet Site Description 
and Address on the same line, separated by an "@" sign (without the quotes). The description 
should come first, followed by the address like this:

The Internet Pearls Index@http://www.execpc.com/~wmhogg

If you are including Category and Notes information, then you need to place them in the order 
Description, Address, Category, and Notes, each separated by the "@" symbol.    Each line begins 
a new page, so all information for one site must be on one line.    

When you select "Import" from the file menu, you will be shown a dialog box in which you should 
indicate which file you want to import.    It is best to try this with a few records in one text file, so 
that if there are any mistakes in preparing the file, only a few records will have to be deleted to 
rectify the problem.



Utilities
There are several useful utilities in the Internet Site Blaster.    The most useful Utility is the Export 
command, found under the File Menu.

The Export function allows you to copy Internet information from the program to your hard disk.    
It allows you to select which Internet Sites to export by entering a search term or phrase, such as 
"game".    The program then looks through the database and selects all of the sites that have 
"game" in their Description field, and copies them to a file you specify on your hard disk, such as 
"game.txt".    Just as with other search functions in this program, the results are usually better 
when you add a wildcard symbol, *, to each end of the word or phrase.    Entering " *game* " , 
instead of just "game", will find the term "game" no matter where it appears in the Description 
field. 

The resulting text file will contain entries such as this:

3-D/Virtual Reality Games @ http://www.cts.com/~pcs/3d.htm
Crafts, Hobbies, and Games @ http://tezcat.com/web/hobbies.html

This is the format that the program's utilities in the registered version use to convert the Internet 
information into Netscape Bookmarks or Mosaic Hotlists.    The Export function lets you select 
information to copy from Site Blaster based on keywords.    Try using the Export function with 
search terms such as *HTML*, *Game*, *Book*, or *Fun*.

A very important utility is the built-in text editor that can be selected from the menu or by pressing
the [F8] function key. 

From the text editor you can open text files that contain Internet information that you want to add 
to the database.    You can also cut-and-paste information from the database to the text editor and 
save this in a text file.

When using the cut and paste method of adding information to a text file, you select the 
information by holding the left mouse key down and dragging it across the desired text in the 
database field.    This will mark the text to be copied.    Then go to the Edit menu item and select 
"Copy".    The information is then saved to the clipboard for you to copy into the text editor or 
other Windows applications, such as your WWW browser, if it allows.    

Certain browsers do not allow direct pasting into their program from the Windows Clipboard, such
as Netscape.    Instead, you have to import the site information into the bookmarks.    The 
Registered version of the program includes a utility to convert information from Internet Site 
Blaster into Netscape (tm) Bookmark format.    The same utility can be used with the Mosaic (tm) 
WWW browser as well.

If you are pasting into the text editor, the next step is to set the focus to the text editor by clicking 
the mouse within the text editor window, and then press the keys CTRL-V to paste the information 
from the clipboard.    

The Table View is particularly helpful here because you can highlight all of the fields for one site 
on a single line and then copy the information to the clipboard from all of the fields at once.    You 
highlight a site in the Table View by using the Up and Down arrow keys to position the bar over 
the site you want to copy.    Then go to the Edit Menu and select "Copy".

The other utilities include functions to tell you about the Status of the file and of the system.    You 
can close the window after the report is displayed by double-clicking on the window control in the
upper left corner of the report. 



You can also perform displays of any directory you choose as well as perform common file 
functions such as copy, rename, display text files, etc.



Menu Command Summary
FILE:

Print - Print current page info.

Print Setup - Choose printer options.

Page Setup - Specify page format.

Indexes - Allows you to add or remove field indexes.

Import - Import Ascii-delimited file into database.

Export - Export Site Blaster information to a Text file.

Exit - Quit program.

EDIT:

Cut - Remove marked information from a field and place it on the Windows clipboard.

Copy - Copy marked information from a field and place it on the Windows clipboard.

Paste - Place the contents of the Windows clipboard at the cursor position in a field or the text 
editor.

Delete - Remove marked text permanently.

Layout - Change the width of the Description field in the Table View.    Use the mouse to adjust the 
width and then click.

VIEW:

Table - Show data in Table format.

Form - Show data in Form style.    This is the default view.

DATA:

Add - Add a new blank page to enter new Internet information.

Change - Modify the information on the present page.

Save - Save the present page to file.

Remove - Delete the present (Current) record, or a Group of records matching a specified set of 
criteria. You will need to fill out the Filter Dialog box to specify which records to delete.    The 
procedure is the same as in Group Find, except that these records will be removed, instead of 
grouped together.

UTILITIES:

Text Editor - Edit text files from within the program.    Paste Internet information from the clipboard



into the Text Editor.

Status - Gives information on the status of the the file and on the system.

Directory - View any directory from within the program.

Files - Perform file operations from with the program.

OPTIONS:

Icon Bar - Set the position of the Icon Bar.

Status Bar - Toggle the Status Bar on and off.

Selection Bar - Set the position of the Selection Bar

System - Change or set the working directory.    The other settings should not be modified.

Display - Set the display font size.    The other settings should not be modified.



Registration Benefits
Registration Benefits

 1. Put the power of the Internet at your    fingertips. Search over 30,000 Internet    Sites in the 
Registered database with    descriptions and addresses, showing how these    sites can be 
reached. By using the Windows clipboard, or the Export command,    you can copy information    
from Site Blaster for use with your favorite WWW browser.

 2. With Registration, you will also receive a utility to convert the Internet Site Blaster site 
information into Bookmarks that can be imported into the your Netscape (tm) browser. This way 
you can export Internet Sites from Site Blaster and make them immediately usable by your 
Netscape WWW program. The utility will also convert site information into Mosaic (tm) Web 
Browser Hot Lists.

 3. Receive "The Internet Primer", a Windows Help file that bursts with useful information on 
numerous Internet topics including Searching the Internet, Internet Starting Points, Using HTML, 
Designing Web Pages, Accessing Free-Nets, Software Libraries, Internet Tutorials and Guides, 
Internet Access    Providers, Helpful Computer Magazines on the Internet, What's New, What's 
Cool, What's Hot, Corporate Computing, and a Complete Listing of the Virtual Libraries available 
on the Internet.      
 
 4. Only the Registered version of Internet Site Blaster is continually edited and updated. To have 
the newest links and the latest updated site information, you'll need the Registered version. As the
web grows, the sites are becoming more interesting and more entertaining. Only the Registered 
version will give you info on what is currently hot on the Internet.
 
 5. No shareware messages.
 
 Even though the Registered database is extensive, 
 it requires little disk space and maintains blazing
 search speed. You can print out the Order Form in
 the text file "Order.frm" that can be found in
 your Site Blaster directory.

 Registration is only $38.00 (U.S.) plus S&H, for the full program, and only $25.00 plus S&H for the 
Site Blaster Lite, which is similar to the full program in every way except that the database is 
limited to 15,000 Internet Sites.

 Here is a partial list of the topics included in
 the Registered Version:

Advertising
Aeronautics
AIDS
Animal
Archeology
Architecture
Art
Astronomy
Australia
Australian Government
Automobiles
Aviation



Bible
Boating
Books
Botany
Browsers
Bulletin Board Systems
Business and Finance
Buying and Selling
California
Canada
Canada Government Resources
CDC - Centers for Disease Control
Census
Chemistry
Christian
Chronic Fatigue Syndrome
Classified Ads
Comics and Cartoons
Commerce
Computers: Hardware
Computers: Shareware
Computers: Social
Computers: Software
Consumer Services
Crafts
CyberThings
Dance
Diabetes
Disability
Disney
Drama
Drugs
Ecology
Economics
Education
Electronics
Environment
Europe
FDA
Federal Government
Football
Fun
Future Technology
Games
Gardening
Geography
Geology
Government
Government Agencies
Government Research Institutes
Graphics
Health
History
Hot/Cool Sites
HTML
Humor



Images
Internet Indexes
Israel
Japan
Jewish Culture and Religion
Jobs
Journalism Resources
Judicial System
K12
Language Studies
Law
Legislation
Libraries
Literature
Lyme Disease
Magazines
Mathematics
MBA
Medicine
Military
Movies
MUDs
Music
NanoTechnology
NASA
NATO
Navy
New York
News
Newsletter
News Magazine
Newt Gingrich
NIH
Pets
Pharmaceuticals
Photography
Physics
Pictures
Poetry
Politics
Quotations
Recreation
Reference: Dictionaries
Reference: Thesaurus
Romance
Russia
Science Fiction
Software Repositories
Sports
Star Trek
State Governments
Statistics
Technology
Telecommunications
Telephones
Television



Texas
The Presidency
Travel
TV
U.S. House of Representatives
U.S. Senate
UFO
UK
USA
Video Games
Virtual Reality
Weather
What's New

Thanks for your interest in our programs!



Ordering
To order the Internet Site Blaster, simply fill out the form found in the file "Order.frm".    Print this 
out and mail it with your payment to SoloTech Software.    You will receive the most recent version 
of the program.    While every effort will be made to mail your order quickly, please allow 7-14 days
for delivery.

New!    The Internet Site Blaster - Lite.      Contains the same program features and registration 
benefits as the full program but has only 15,000 Internet Sites in the Database at a reduced price. 
See "Order.frm" for details.    






